
 

 
 

Using SAAM II 
 

Working with Parameters, 
Advanced 

 
Introduction ParUS –   2 

Part 1. Zero order parameters ParUS –   3 

Part 2. Specifying variables in the Equations dialog box ParUS – 17 

Part 3. Reparameterizing the two-compartment model ParUS – 21 

Part 4. Setting parameter limits ParUS – 29 

Part 5. Using Bayesian parameters ParUS – 41 
 
 
 

 

2002 - 2005 University of Washington   .  



 

2002 - 2005 University of Washington   .  



Using SAAM II Working with Parameters 

Working with Parameters, Advanced 
 
Prerequisites 
 

The prerequisites for this tutorial are having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental” and the 
tutorial “Working with Parameters, Basic.” 

 
What you will learn in this tutorial 
 
The tutorial, “Working With Parameters, Basic”, showed you how to use the different 
options in SAAM II to define and use the most commonly used types of parameters.  The 
purpose of this tutorial is to show you how to use the additional options in SAAM II to 
define and refine parameters. You will learn 

 
• How to create zero order losses (Part 1) 
• How to write parameters and variables in the Equations window (Part 2) 
• How to reparameterize the two-compartment model (Part 3) 
• How to set parameter upper and lower limits (Part 4) 
• How to use the Bayesian option (Part5) 
 

This tutorial is divided into parts to which you can refer individually for specific 
information. Since you know how to enter parameters in the Parameters dialog box, you 
can proceed to any specific part of this tutorial without needing the information that 
preceded it. 
 
Files Required 
 

Study Files: The study files for this tutorial are 
 

study_0.stu 
Para_Limits 

 
These files are included as part of this tutorial. The file study_0.stu is the same as 
study_0.stu that is installed in the SAAM II program folder and referred to in the 
SAAM II User Guide. The file Para_Limits is a one-compartment model with 
two parameters. 
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Introduction 
 
This tutorial is designed to show you have to use the additional options available in 
SAAM II to work with parameters. 
 
In general, most losses are first-order or nonlinear as covered in the tutorial, “Working 
with Parameters, Basic.”  There may be instances, when the loss is at a constant rate 
independent of the mass in the ith compartment.  In these cases, a zero-order loss is 
required. Part 1 of this tutorial shows how to create a zero-order loss.  Zero-order inputs 
can also be created, but these are equivalent to constant infusions. 
 
A multicompartmental model in SAAM II is specified by the compartments, transfers and 
losses. The transfers k(i,j) and losses k(0,i) specify the terms in the different differential 
equations created internally by SAAM II. These are called the primary parameters. Often 
there are a number of parameters – volumes, clearances, absorptions – that are functions 
of these primary parameters. These parameters can be specified as variables in the 
Equations dialog box. This procedure is explained in the 5th tutorial. Some models such 
as the commonly used two-compartment model can be reparameterized based upon the 
desired secondary parameters; this is illustrated in the 6th tutorial. 
 
All adjustable parameters must have initial values specified with high and low limits. For 
an adjustable parameter, if you simply enter a value and click Save, SAAM II will create 
default high and low limits that are 10 times and 0.1 times the initial value. SAAM II 
actually uses the information in the limits as part of fitting. The information is a measure 
of how well you think you know your limits. As will be illustrated in the 7th tutorial, if 
your limits are widely divergent from the initial value, you may have trouble fitting. This 
is because SAAM II thinks you don’t know the parameter very well. On the other hand, if 
you know a parameter reasonably well, this information should be included when you set 
the limits. 
 
Finally, SAAM II has implemented a partial Bayesian option. This is explained in the 8th 
tutorial. The Bayesian option provides a means by which a priori information about a 
specific parameter, or parameters, can be entered in the Parameters dialog box. 
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Part 1. Creating a zero-order loss 
 
In general, most losses are first-order or nonlinear. There may be instances, however, 
when a zero-order loss is required. The difference is the following. For the ith 
compartment, the loss is generally expressed (in terms of the differential equation): 
 

 K+⋅−= )(),0( tqik
dt

dq
i

i  

 
That is, the loss is proportional to the mass in the ith compartment. In the case of the zero-
order loss, this is not the case: 
 

 K+−= ),0( ik
dt

dqi  

 
That is, the loss is at a constant rate independent of the mass in the ith compartment. This 
tutorial will explain how to create zero-order losses. 
 
Incidentally, by the same logic, you can see why a zero-order input and a constant 
infusion are the same. If Compartment 1 transferred material to Compartment 2 via a 
zero-order process,   
 

 K+= )1,2(2 k
dt

dq  

 
The parameter k(2,1) is simply a constant rate of input, and hence, in SAAM II notation, 
is equivalent to 
 

 K+= )2(2 ex
dt

dq  

 
where ex(2) is specified as a constant infusion. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 
 

a. The file study_0.stu should appear in the file list; if it does not, find the folder 
where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 
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3. View the model and the experiment on the model, and the Parameters dialog 
box. 
 
a. In the SAAM II Toolbox, click Experiment. The model of the experiment 

will appear as follows: 
 

 
 
b. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. The 
Parameters dialog box should appear as follows: 
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These are the parameters for study_0.stu. 
 

4. Modify k(0,1) so that it is a zero-order loss. 
 

a. Double-click k(0,1) to open the Loss Attributes dialog box. 
 
b. In the Equation pane, type “k(0,1)=k_loss/q1”. The Loss Attributes dialog 

box will appear as follows: 
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c. Click Done. 
 
The result is that k(0,1) is no longer a primary model parameter, but is a function 
of a new parameter, k_loss. In the differential equation for q1: 
 

LLL +−=+⋅=+⋅−= lossktq
tq

lossktqk
dt

tdq
_)(1

)(1
_)(1)1,0(

)(1  

 
The result is now the loss from Compartment q1 is zero-order, and specified by 
k_loss. A value for this parameter must be entered in the Parameters dialog box. 
 

5. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 

click Parameters . The Parameters dialog box will open. 
 

a. Type “1” as the Value for K_loss, and click Save. The Parameters dialog 
box will appear as follows: 
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b. Click Done. 
 

6. Solve the model, and view the solution. A plot of the solution is shown as 
follows: 
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It is of interest, however, to plot k(0,1) which is no longer a constant but a 
function of time since q1(t) appears in the equation defining it. While this is the 
case, the rate of loss, flux(0,1), should be constant. Both will be plotted. 

 
a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . Open the Plot and Table Variables dialog box, and be sure 
the List All Variables check box is selected. 

 
b. Click k(0,1) to move this to the Current Selection pane. The Plot and Table 

Variables box will appear as follows: 
 

 
 

c. Click Done. The plot of k(0,1) will appear as follows (in linear mode): 
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d. Open the Plot and Table Variables dialog box, and select flux(0,1) as the 
Current Selection. When you click Done, the following plot of flux(0,1) 
should appear: 

 

 
 

This is a constant indicative of the loss from Compartment q1 being zero-
order. 
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e. Close the Plot window. 
 

7. Restore the original study_0. 
 

a. Open the Loss Attributes dialog box associated with k(0,1), and delete the 
equation “k(0,1)=k_loss/q1”. Click Done. 

 
b. Open the Parameters dialog box. Notice k_loss no longer appears; k(0,1) 

does. Select k(0,1), and type “0.1” in the Value box. Click Done. This should 
restore the original settings in study_0. 

 
c. Re-Solve the model. If you open the Plot window, since flux(0,1) was the 

previous plot, the Plot window will appear as follows: 
 

 
 

The flux is no longer a constant since the loss is now a first-order process. If 
you wish, you can change the plot to s1:plasma to be sure you have restored 
the original solution for study_0. 

 
d. Close the Plot window. 
 

8. Create a zero-order loss from Compartment 2. 
 

a. In the SAAM II Toolbox, click Model. The Model tools are now available. 
 
b. Create a loss k(0,2). 
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c. In the SAAM II Toolbox, click Experiment. The model will appear as 
follows: 

 

 
 
d. Double-click k(0,2) to open the Loss Attributes dialog box. 
 
e. In the Equation pane, type “k(0,2)=k_loss/q2”. The Loss Attributes dialog 

box will appear as follows: 
 

 
 
f. Click Done. 
 
g. Open the Parameters dialog box, double-click k_loss to make it the current 

selection, and type “1” in the Value box. Click Save. The Parameters dialog 
box will appear as follows: 
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Click Done. 

 
h. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . The following error message will appear: 
 

 
 
Close the Compute Log. 
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  Division by zero. What is happening in this situation is that, at time zero, there 
is no mass in Compartment q2, i.e. q2(0) = 0. Remember k(0,2) has been 
defined by the equation k(0,2) = k_loss/q2. This cannot be evaluated at time 
zero. There are two solutions to this problem. The first solution is to change 
the equation for k(0,2) slightly. You know what the mass will be in the 
compartment because of the magnitude of the initial conditions in 
Compartment q1. Using a number much smaller, you can modify the equation 
for k(0,2) to, for example, k(0,2) = k_loss/(q2+0.00001). The second solution 
is to introduce a very small bolus into Compartment q2, e.g. ex2 = 0.0001. 
Neither will have a significant effect on the solution. 

 
 

i. Method 1: Modify the equation for k(0,2). 
 

(1) Open the Loss Attributes dialog box associated with k(0,2). 
 
(2) Change the equation to read “k(0,2)=k_loss/(q2+0.00001). The Loss 

Attributes dialog box will appear as follows: 
 

 
 
(3) Click Done. 
 
(4) Re-Solve the model. This time, the solution will be successful, and a plot 

of s1:plasma will appear as follows: 
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(5) Close the Plot window. 

 
j. Method 2: Introduce a small bolus into Compartment q2. 
 

(1) Open the Loss Attributes dialog box associated with k(0,2), and re-enter 
the original equation “k(0,2)=k_loss/q2”. Click Done. 

 
(2) In the SAAM II Toolbox, click Input. 
 
(3) Click Compartment q2 and then the Drawing Canvas. The input ex2 will 

appear associated with Compartment q2. The model will appear as 
follows: 

 

 
 
(4) Double-click ex2 to open the Exogenous Input dialog box. 
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(5) Enter a bolus of 0.00001. The Exogenous Input dialog box should appear 
as follows: 

 

 
 
(6) Click Done. 
 
(7) Re-Solve the model. This time, the solution will be successful, and a plot 

of s1:plasma will appear as follows: 
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This plot is essentially identical with that obtained using the first method. 
 

(8) Close the Plot window. 
 

  Zero-order losses. If you specify a zero-order loss from a compartment in 
your model where the initial conditions in that compartment are non-zero, the 
method described for k(0,1) is the method to use. If you specify a zero-order 
loss from a compartment whose initial conditions are zero, you must use 
either of the two methods described above to eliminate the problem of 
division by zero. Either method works fine – it is a matter of personal 
preference. 

 
 

 
Quit the SAAM II Compartmental application. Do not save the changes to study_0.
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Part 2. Specifying parameters and variables in the Equations window 
 
This part of the tutorial will show you have to specify parameters in the Equations 
window. You have seen how equations involving parameters can be written in the 
Transfer or Loss Attributes dialog boxes. Writing such equations in the Equations 
window is another option in SAAM II. In pharmacokinetic studies, this is how you would 
enter the pharmacokinetic parameters that are functions of the model parameters; 
examples are clearances and volumes. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 
 

a. The file study_0.stu should appear in the file list; if it does not, find the folder 
where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 

 

 
 

3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear as follows: 
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4. In the Show menu, click Equations, or alternatively, on the SAAM II Toolbar, 

click Equations . The Equations dialog box will open. 
 

a. Enter the following equations in the Equations Defined Here pane: 
 

CLe = vol*k(0,1) 
vol2 = vol*k(2,1)/k(1,2) 
Vss = vol + vol2 
Frac_01=k(0,1)/(k(2,1)+k(0,1)) 

 
CLe is the clearance of material from Compartment 2. vol2 is the volume of 
Compartment 2 assuming the concentrations in Compartments 1 and 2 are the 
same. Vss is the total system volume, or equivalent volume of distribution. 
Frac_01 is the fraction of material in Compartment 1 that is irreversibly lost. 
 
When you have finished, the Equations dialog box should appear as follows: 
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b Close the Equations dialog box. 
 

5. Fit the model to the data, and view the solution and statistics. The results are 
summarized in the following: 
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The “Fit” is quite good as are the statistics. Note statistical information on the 
parameters you defined in the Equations dialog box appear as Derived Variables 
in the Parameter/Variable pane of the Statistics window. 
 

5. Close the Plot and Statistics windows. 
 
Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
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Part 3.  Reparameterizing the two-compartment model 
 
It is sometimes desirable to reparameterize a model so that the desired pharmacokinetic 
parameters become the model parameters. In this part of the tutorial, the two-
compartment model with loss from the plasma compartment will be reparameterized. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 
 

a. The file study_0.stu should appear in the file list; if it does not, find the folder 
where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 

 

 
 

3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear as follows: 
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4. Re-specify the model parameters. 
 

The model parameters as the model is currently configured are vol, k(2,1), k(1,2) 
and k(0,1). The model will be reparameterized in terms of clearances. The 
equations which will be used are: 
 

CLe = vol*k(0,1) 
CLi = vol*k(2,1) 
vol2 = vol*k(2,1)/k(1,2) 
Vss = vol + vol2 
 

In SAAM II, these will be rewritten: 
 

k(0,1) = CLe/vol 
k(2,1) = CLi/vol 
k(1,2) = CLi/vol2 
 

The result will be that the model parameters become CLe, CLi, vol and vol2. 
 
a. Double-click k(0,1) to open the Loss Attributes dialog box. 
 
b. In the Equations pane, type “k(0,1)=CLe/vol”. The Loss Attributes dialog 

box will appear as follows: 
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c. Click Done. 
 
d. Double-click k(2,1) to open the Transfer Attributes dialog box. 
 
e. In the Equation pane, type “k(2,1) = CLi/vol”. The Transfer Attributes 

dialog box will appear as follows: 
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f. Click Done. 
 
g. Double-click k(1,2) to open the Transfer Attributes dialog box. In the 

Equations pane, type “k(1,2) = CLi/vol2”. The Transfer Attributes dialog 
box will appear as follows: 
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h. Click Done. 
 
At this point, your model has been reparameterized. 
 

4. Enter the parameter values. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open as 
shown below: 

 

 
 

The estimate for vol can remain. You need to provide initial estimates for 
CLe, CLi and vol2. 

 
b. An initial estimate for CLe is 700, for CLi is 400 and vol2 is 1500. When you 

enter these values, the Parameters dialog box should appear as follows: 
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Click Done to close the Parameters dialog box. 
 

6. Solve the model and view the solution. The initial parameter estimates are 
reasonable so you can proceed to Fit the model to the data. 

 
7. Fit the model to the data and view the results. A summary of the results is shown 

as follows: 
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  Model reparameterization. In the above situation it is quite easy to 
parameterize the model in terms of the pharmacokinetic parameters. The 
results here should be essentially the same as the part in this tutorial where 
these parameters were defined in the Equations dialog box. Notice in this case 
the k(i,j) become the derived variables. 

 
For the one-compartment model, the one-compartment model with absorption 
and the three-compartment model, reparameterization is relatively 
straightforward. However, in instances when there is a single-input multiple-
output study (e.g. plasma and urine samples), when the model has more than 
four compartments, or when the model is nonlinear, reparameterization can be 
a very tricky bookkeeping exercise, and should be conducted with caution. 
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7. Close the Plot and Statistics window. 
 
Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
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Part 4.  Work with parameter high and low limits 
 
In the Parameters dialog box, for each adjustable parameter you must specify a Low and 
High Limit. SAAM II uses this information when you Fit your model to your data. It 
interprets the values for the Low and High Limit as a measure of the confidence you 
have in your knowledge of a particular parameter. SAAM II is very forgiving in these 
values, but if a particular limit strays too far from the Value, it can affect the statistical 
results following a Fit. 
 
This tutorial will illustrate what can happen using a simple one-compartment model with 
two parameters, a loss k(0,1) and a volume parameter vol. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file Para_Limits. 
 

a. The file Para_Limits.stu should appear in the file list; if it does not, find the 
folder where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 
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3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear as follows: 
 

 
This study file contains a set of monoexponentially decaying data. The default 
weighting value has been changed from the default “data-relative” to “data-
absolute”. This can be verified by viewing the Computational Settings dialog 
box which will as appear as shown below: 
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4. Solve the model and view the solution 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. Be sure 
the List All Variables check box is not selected. 

 
c. Click s1:plasma to move this to the Current Selection pane. 
 
d. Click Done. If the plot is not in semilog, in the View menu, click Semilog. 

The plot will appear as follows: 
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e. Close the Plot window. 
 

5. Perform a series of Fits with the Low and High Limit of k(0,1) set at different 
values. The Low and High Limits of the parameters in Para_Limits have been 
set using the default values in SAAM II. The Parameters dialog box will appear 
as follows: 
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Perform a series of Fits with the Low and High Limit of k(0,1) set at the values 
shown in the following table. The left-hand columns are the Low and High Limit 
for k(0,1). The columns “k(0,1)(CoeffVar)” and “vol(CoeffVar)” are the final 
parameter values and coefficients of variations respectively. The column “Obj” is 
the value of the objective function following the Fit. 
 
k(0,1) Limits k(0,1)(CoeffVar) vol(CoeffVar) Obj

[0.001,0.1]

[0.005,0.05]

[0.0001,1.0]

[1.0e-07,100]

[0,1000]

[0,0.1]  
 

You should fill in this table starting with the default Low and High Limit of 
k(0,1) respectively equal to 0.001 and 0.1. After the first fit, your table should 
appear as follows: 
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k(0,1) Limits k(0,1)(CoeffVar) vol(CoeffVar) Obj

[0.001,0.1] 0.0089(7.4) 3288(4.4) 10.65

[0.005,0.05]

[0.0001,1.0]

[1.0e-07,100]

[0,1000]

[0,0.1]  
 
You should reset the initial estimates of the parameters to their original values of 
0.01 and 3400 respectively, and set the Low and High Limits for k(0,1) equal to 
0.005 and 0.05 respectively for the second Fit. You should continue in this 
fashion until you have completed the table which should appear approximately as 
follows: 
 
k(0,1) Limits k(0,1)(CoeffVar) vol(CoeffVar) Obj

[0.001,0.1] 0.0089(7.4) 3288(4.4) 10.65

[0.005,0.05] 0.0089(7.4) 3288(4.4) 10.65

[0.0001,1.0] 0.0089(7.4) 3288(4.4) 10.65

[1.0e-07,100] 0.0089(7.9) 3288(4.5) 10.65

[0,1000] 0.0089(14.2) 3288(5.3) 10.65

[0,0.1] 0.0089(7.4) 3288(4.4) 10.65  
 
After each Fit, you can check the plot of s1:plasma. As expected, it will not 
change since the parameter values do not change, as noted above. 
 
What you should observe in this exercise is that, when you can Fit successfully, 
the Low and High Limits will have little or no effect on the parameter estimates 
themselves, or the value of the objective function. What will be effected are the 
estimated coefficients of variations. However, in this instance, the limits have to 
move far away from the Value before this becomes noticeable. Thus SAAM II is, 
in general, robust. 
 
Understanding the effect of high and low parameter limits becomes crucial is 
when you have a large model with many parameters, some of which may be better 
estimated from the data than others. Here setting the Low and High Limits can 
have a dramatic effect on the final results. 

 
Close all open windows and dialog boxes. 

 
Quit the SAAM II Compartmental application. Do not save the changes to 
Para_Limits. 
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Some additional comments on parameter limits are necessary. 
 
The previous tutorial illustrated a simple case of setting the parameter limits on one 
parameter. In linear compartmental models, SAAM II is quite forgiving in setting these 
limits. There are instances when limits must be set, or instances when realistic limits must 
be set in order to achieve a successful fit of the model to the data. 
 
An example of an instance in which a limit must be set rather than using the default value 
is the following. Suppose you have a delay in your model where there are two losses 
from the delay. This is illustrated in the following model: 
 

 
 
There are two possible routes by which material can leave Delay 2. Remember in SAAM 
II, loss from a delay is a fraction, i.e. a fraction of the material in the delay along the 
possible routes of loss. When there is only one loss, the fraction is 1. In this situation 
above, d(3,2) + d(4,2) = 1, and both d(3,2) and d(4,2) must lie between 0 and 1. A 
convenient way of doing the bookkeeping is the following. You can define 
 

d(3,2) = frac 
 
and 
 

d(4,2) = 1 – frac 
 
frac becomes a parameter for which a Value, Low Limit and High Limit must be 
specified. If you enter, for example, 0.5 in the Value box and use the default limits, the 
Low Limit will be 0.05 which is okay, but the High Limit will be 5 which is not okay 
since if in the process of fitting, frac goes above 1, d(4,2) will become negative and 
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Conservation of Mass will be violated. Thus you must determine Low and High limits 
for frac that lie between 0 and 1. 
 
Another example of where setting reasonable parameter limits rather than using the 
default values is the following example which will use the SAAM II Numerical 
application. The data to be analyzed are shown in the following plot: 
 

 
 
These data are cholesterol concentrations in 40 subtractions of high density lipoprotein. 
The problem is to describe these data by a Sum of Gaussians using the SAAM II 
Numerical application. 
 
A Gaussian is a function of the form 
 

 
f (t) =

1
2πσ

exp −
1
2

t − µ
σ

 
 

 
 

2 

  
 

  − ∞ < t < ∞
 

 
where, in this expression, µ  is called the mean and σ  the standard deviation. It is known 
that the area under this so-called bell shaped curve is unity, i.e. 
 
  . f (t)dt

−∞

∞

∫ =1
 
The mean µ  determines the location while the standard deviation σ  provides a measure 
of the "sharpness" of the gaussian. That is, the smaller the σ , the narrower the peak. 
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A sum of four Gaussians will be used to describe these data. In SAAM II, a single 
Gaussian is written: 
 

A1/(SA1*2.51)*exp(-((t-MA1)^2)/(2*SA1^2)) 
 

Where A1 is a parameter characterizing the magnitude of the contribution of the 
Gaussian. SA1 and MA1 are the standard deviation and mean of the gaussian. 2.51 
approximates π2 . Thus the single Gaussian term has three parameters, A1, SA1 and 
MA1. Thus in the sum of four Gaussians, there will be 12 parameters, and the expression 
will be: 
 
ya(t) = A1/(SA1*2.51)*exp(-((t-MA1)^2)/(2*SA1^2)) + A2/(SA2*2.51)* 
exp(-((t-MA2)^2)/(2*SA2^2)) + A3/(SA3*2.51)*exp(-((t-MA3)^2)/(2*SA3^2)) + 
A4/(SA4*2.51)*exp(-((t-MA4)^2)/(2*SA4^2)) 
 
Initial estimates for the four means, MA1, MA2, MA3 and MA4 can be obtained by 
looking at the data and estimating where the peaks may lie. Similarly initial estimates for 
the four standard deviations can be obtained again just by looking at the sharpness of the 
peaks. The Parameters dialog box could appear as follows: 
 

 
 
Initial estimates were obtained visually, and default values for the Low and High Limits 
have been used. When the model are fitted to the data (with the FSD option), the best fit 
is shown as follows: 
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Obviously this is not satisfactory. Neither are the statistics which are shown below: 
 

 
 

What is happening is that the limits set on the means and standard deviations are not 
realistic using the default values. For example, the High Limits for all the means are well 
beyond the data which end at “40”. Visually, more realistic estimates for the Low and 
High Limits for both the means and standard deviations can be obtained visually. Below 
is the Parameters dialog box with just such a set of more reasonable estimates: 
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You can see the limits for the means and standard deviations are much closer to their 
initial estimated Values. The default limits on the Ai are okay since these are linear 
parameters and are not that sensitive to the limits. 
 
Using these initial estimates and limits, if you fit the model to the data (with the FSD 
option), you will obtain the following fit: 
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The statistics are also satisfactory: 
 

 
 
This example thus illustrates the need to be aware of setting limits on your adjustable 
parameters, and to pay attention to how they may need to change as you go through your 
modeling exercise. 
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Part 5. Using the Bayesian option to incorporate prior knowledge 
 
What happens if you have prior information about a parameter in your model? It may be 
the case, for example, a relationship between two parameters has been developed as a 
result of research conducted elsewhere. How can you incorporate this knowledge in your 
model? 
 
One way you can incorporate priori knowledge is to use the Bayesian option in SAAM II. 
This part of the tutorial will illustrate how this can be done. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 
 

a. The file study_0.stu should appear in the file list; if it does not, find the folder 
where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 

 

 
 

3. View the model and the experiment on the model, and change the model. 
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a. In the SAAM II Toolbox, click Experiment. The model of the experiment 
will appear as follows: 

 

 
 

b. Modify the model by adding a loss from Compartment 2. Your model for the 
experiment should appear as follows: 

 

 
 

4. Specify a relationship between k(0,1) and k(0,2). 
 

Suppose from the literature there is a known relationship between k(0,1) and 
k(0,2). Suppose it is known that k(0,1) is approximately twice k(0,2). How can 
this be incorporated in the model? 
 
a. Double-click k(0,1) to open the Loss Attributes dialog box. 
 
b. In the Equations pane, type “k(0,1) = a * k(0,2)”. The Loss Attributes dialog 

box will appear as follows: 
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c. Click Done. A new parameter, a, has been added to the model. 
 

5. Enter a value for a, and Solve and Fit the model to the data. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
 
b. Be sure a is selected. Set a as a fixed parameter, type “2” in the Value box, 

and click Save.  
 
c. Double-click k(0,2) to select it. Type “0.05” in the Value box, and click Save. 

The Parameters dialog box will appear as follows: 
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d. Click Done. 
 

6. Solve the model. The initial parameter value, while not great, are sufficient to 
proceed with a “Fit”. Fit the model to the data and view the solution. A summary 
of the “Fit” is shown in the following: 
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Close the Plot and Statistics windows. 
 
In this case, a was assumed to be known and equal to 2. The result is that there are 
four parameters to be estimated from the data, and the “Fit” was successful. What 
would happen is a was adjustable? 

 
7. Set a as an adjustable parameter. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
 
b. Double-click a to select it. 
 
c. Set a as an adjustable parameter. Leave the initial Value equal to “2”. Type 

“0.5” and “5” in the Low Limit and High Limit boxes respectively. The 
Parameters dialog box will appear as follows: 
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d. Fit the model to the data. The following warning message will appear: 
 

 
 

The warning is that a hit a lower limit. If you continue to adjust the Low 
Limit, a will continue to hit the lower limit. This means there are more 
parameters in the model than can be estimated from the data. 
 

e. Close the Compute Log dialog box. 
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8. Incorporate prior knowledge about a into the model. 
 

Suppose you really believed that k(0,1) was about twice k(0,2). Suppose you had 
information on the value of a from another study. You can incorporate this 
knowledge using the Bayesian option in SAAM II. Suppose you know from the 
literature that a value for a is “2” with a standard deviation of “0.05”. In this part 
of the tutorial, this information will be incorporated into the model. 
 
a. In the Compute menu, click Settings. The Computational Settings dialog 

box will open. 
 
b. Select the Include Bayesian Term check box. The Computational Settings 

dialog box will appear as follows: 
 

 
 

c. Click Done. 
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d. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
 

(1) Double-click a to select it. 
 
(2) Select the type for a as Bayesian. 
 
(3) Type “2” in the Mean box and “0.05” in the SD box.  
 
(4) Click Save. The Parameters dialog box will appear as follows: 
 

 
 

(5) Click Done. 
 

  The Bayesian option. If you have information about the value of a model 
parameter from the literature, it is useful to include this in your model. When 
you have Bayesian parameters in your model and you fit your model to your 
data, SAAM II takes this information into account. If there is information in 
your data about a Bayesian parameters, SAAM II will adjust it from its mean 
value. If there is little or no information in your data about a Bayesian 
parameters, SAAM II will not adjust it from its mean value. 
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e. Fit the model to the data. A summary of the results is shown below: 
 

 
 

  Bayesian parameters. The Bayesian parameter option is a powerful way to 
incorporate prior information about a parameter in your model. In almost all 
cases if you use this option, you will achieve convergence. If your data do not 
contain much information about the Bayesian parameter, then the value you 
entered for the Mean and SD will not change much; if your data do contain 
information, they will change. In this case, the Mean didn’t change; the SD 
changed a little. 

 
You should note that the precision of the model parameters is not as good as 
the case, for example, when there were only four parameters to be estimated. 
This is because of the additional uncertainty added by the Bayesian parameter. 
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Using this option can also be useful as a modeling technique. If in the process 
of developing a model you cannot achieve a fit, you can sometimes use the 
Bayesian option on a specific parameter. You can then tell from the resulting 
statistical output which of the model parameters may be giving difficulty in 
achieving a “Fit.” This can help identify where constraints on parameters or 
model simplification must be undertaken. 

 
 
 

f. Close the Plot and Statistics windows. 
 

Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
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